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Understanding the program elements in
MARConnect

MARConnect is a Windows program that helps you catalog web sites and create MARC
records that can be imported into Spectrum CIRC/CAT or other library automation
systems. MARConnect is automatically installed with the Windows version of Spectrum
CIRC/CAT. Note: MARConnect is not available for Macintosh.

For more information on using MARConnect, see "Using MARConnect" in the
MARConnect chapter of the Spectrum CIRC/CAT User Manual.

For information on MARC records, see "Understanding MARC records" later in this
manual.

About the Options window
You can accept the default options as your settings, but Sagebrush recommends that you
set specific options for your library before you catalog and save MARConnect records.

Options window
In this window, you set
options for the
MARConnect program.
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Below are descriptions of the different options you can set in the Options window. Most
options let you define the information that is stored in a pre-assigned MARC 21 tag, such
as material number, control number, control number identifier, language code, cataloging
source, computer file or data note, and system details note. Some options let you define
where information will be placed in a MARC record, such as the "Place web site
assessment in tag" and "Subfield" option. Other options, such as the "Text to precede
assessment", "Material type", and "Call number" options, let you define information
specific to your library.

Option Description

Material number This field’s value indicates the material number that is used
for the first MARC record that gets saved. It is stored in tag
852 subfield_p. If it’s empty, no 852 or 961 tag is generated.
MARConnect automatically increments the rightmost group
of characters (numeric only) after each subsequent save.

Note: Assigning a material number in the MARConnect
Options window does not necessarily give the MARC records
that material number when importing in Spectrum
CIRC/CAT. When you import the MARC file into Spectrum
CIRC/CAT, you can choose whether to use the incoming
material assigned in MARConnect or a sequence of numbers
starting at a specified number.

Control number This field’s value is entered in the 001 tag the first time you
save a MARC record. MARConnect automatically increments
the rightmost group of characters (numeric only) after each
subsequent save.

Control number
identifier

This field’s value is entered in the 003 tag. This is the MARC
21 code for the agency whose control number is found in field
001 (control number). (The source of this code is Symbols of
American Libraries maintained by the Library of Congress.)
The default is "MnCdSW-A".
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Option Description

Language code This field’s value is entered into the language code portion of
the 008 tag. Language codes must be exactly three characters
in length. Some common language codes are: eng – English,
spa – Spanish, ger – German, fre – French, and rus – Russian.
The default is "eng".

Cataloging source This field’s value is automatically entered into tag 040
subfield _a of a MARC record. This is the MARC 21 code of
the name of the organization(s) that created the original
record or modified an existing record. (The source of this
code is USMARC Code List for Organizations, maintained by
the Library of Congress.) The default is "Customer".

Type of computer
file or data note

Notes that describe the computer file. This field’s value is
automatically entered into tag 516_a. The default is "File is in
HTML format".

System details note This is the mode of access. This field’s value is automatically
entered into tag 538_a of a MARC record. This field in a
MARC record contains system information about an item.
This is blank by default.

Text to precede
assessment

Text entered into this field is automatically entered to your
quality rating of a web site when a MARC record is
generated. If you want your quality rating to have descriptive
text precede it, enter the text here. The default is "Quality
rating (1 = low, 5 = high)".

Place web site
assessment in tag

This field’s value determines which field in a MARC record
stores your web site quality rating. If you do not want to store
a quality rating, leave this field blank. The recommended tag
is 514.



MARConnect: Understanding the program elements in MARConnect 443
SCC5rm1200kn

Option Description

Subfield This field’s value determines which subfield stores your web
site quality rating. Any alphanumeric value is accepted. The
default is subfield a.

Material type This field’s value is stored in tag 961_t. You should assign a
unique material type number to this field. This lets you to
easily exclude your MARConnect records from your
inventory process because MARConnect records don’t have
barcode labels to wand. The default is 1.

Call number This field indicates which type of call number is used in your
library. You can choose either LC (Library of Congress) or
Dewey. The type you choose determines which label (either
LC or Dewey) is displayed in the data-entry window.

About the MARConnect window
In the MARConnect window, you capture and enter catalog information for the web site
displayed in your browser. To find out what tag in the MARC record each field is stored
in, see "Mapping MARConnect fields to a MARC record".

MARConnect
window
In this window, you
can catalog Internet
web sites.
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The following table describes the elements in the MARConnect window.

Note Description

URL Uniform Resource Locator (also called a Web address). A
string of letters and/or numbers that locates a web site. For
example, http://www.sagebrushcorp.com is the URL that
links you to Sagebrush’s web site.

The MARConnect program automatically captures the URL.

Author –
personal

The name of a person or family that created a web site.

You can enter up to three personal authors. Because of
MARC standards, you can only enter one main entry for
author, either personal or corporate, but not both.

Author –
corporate

The name of a commercial entity that produces media such as
a company or group, examples include IBM or SADD
(Students Against Drunk Driving).

You can enter up to three corporate authors. Because of
MARC standards, you can only enter one main entry for
author, either personal or corporate, but not both.

Title The title of a web site that describes what the site is about.
The title is the text displayed in the title bar of the browser
window.

The MARConnect program automatically captures the title.

Subtitle A web site’s subtitle (or remainder of the title).

Alternate title A web site’s alternate title.
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Note Description

Publisher The publisher of a web site. In some cases web sites won't
have a publisher listed, but they might have a host name
listed, such as Geocities. In these cases, you could substitute
the publisher title with the host name.

Some web sites may not supply you with all of the
publication information. In these cases, you can leave those
areas blank.

Place of
publication

The place where the material was published (for example,
Chicago).

Date of
publication

The date that the material was published (for example, 1979).
You could also use the date the web site was posted or last
updated.

The quality of
this page or
site

This is a subjective rating that you can assign to a web site.
Possible values range from 1 (poor) to 5 (excellent). The
default value is 3.

General note Contains general information about a material, in this case a
web site. This information is stored in tag 500_a of a MARC
record.

Summary Contains information that describes the general contents of
the described material. A summary, an abstract, a review, or
simply a phrase describing the material or web site could go
in this field. This information is stored in tag 520_a of a
MARC record.

Public note Contains information relating to the electronic location of the
source (web site) identified in the URL and title fields. This
information is stored in tag 856_z of a MARC record.
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Note Description

Audience
characteristics

Lets you choose the audience characteristic and the audience
type for a site from the appropriate menus.

Dewey or LC
call number

The Dewey or Library of Congress call number for a web
site. The type you choose in the Options window determines
which label is shown next to the call number box in the
MARConnect window.

If you enter LC call numbers, this information is stored in tag
050_a of a MARC record. Dewey call numbers are stored in
tag 082_a.

Local call
number

Contains local information. This field could contain an
indication (such as WWW) that this is a web site rather than a
book or other physical material in your library. Or, it could
contain information indicating where similar information is
shelved in the library.

This number is stored in tag 090_a of a MARC record.

First subject A description of the web site’s subject matter. You can enter
up to five main subjects.

Subdivision You can enter up to three subdivisions for each main subject
entry.
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About the MARConnect button
The MARConnect button captures the URL and title of the web site currently displayed
in your browser and places them in the appropriate boxes in the main MARConnect
window. When you find a site you want to catalog, click the MARConnect button and the
MARConnect window opens with the new site’s URL and title already entered.

The MARConnect button remains on top of all windows unless you minimize the main
MARConnect window. When you do this, the MARConnect button is hidden until you
show the main window again. Also, when you catalog and save a site, the MARConnect
window goes to the background so you can use your browser to search for another site.

You can move the MARConnect button to a different location on your desktop. Use your
mouse to place the pointer in the title bar at the top of the button. Click and hold down
the mouse button while you drag the MARConnect button to a new location on your
desktop.

About the MARConnect menu commands and
toolbar
The MARConnect window contains five menus. The commands in these menus help you
catalog web site information and save it as MARC records that can be imported into
Spectrum CIRC/CAT. Where available, shortcut keys are listed next to the command in
the menu.

For many of the menu commands, there are also corresponding buttons in the toolbar.

If the toolbar buttons are not visible, select the Toolbar option from the View menu.

MARConnect
button
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File menu commands
The File menu contains commands to create a new MARC file, open an existing MARC
file, and close the program.

Command Button Description

New File n/a Opens the New File window, where you can specify
the filename and location for a new MARC file. In
most cases, you can continue to save all of your
MARC records to the default MARC file
(Marc_001). However, if you do create a new file,
you should save it in a location that is easy to find,
such as the Spectrum program folder.

The default MARC file is located in c:\Program
Files\Winnebago\Spectrum Client or c:\Program
Files\Winnebago\Spectrum Single, depending on
which version of Spectrum you use.

This command is different than the New Record
command, which creates a new MARC record in the
existing MARC file.

Open n/a Opens an existing MARC file that contains MARC
records.

Exit n/a Closes the MARConnect program.
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Edit menu commands
The Edit menu contains standard Windows commands to cut, copy, paste, clear, and
select all text from program fields. It also contains commands to automatically catalog
the current web site’s URL and title and check the MARC record’s spelling.

Command Button Description

Cut n/a Deletes the selected text and places it in the
clipboard.

Copy n/a Copies the selected text into the clipboard.

This command is different than the Copy to
Clipboard command. The Copy command only copies
selected text in one box. The Copy to Clipboard
command copies an entire MARC record to the
clipboard.

Paste n/a Pastes text from the clipboard into the box where
your cursor is located.

Clear n/a Deletes the selected text. It does not place it into the
clipboard.

Select All n/a Selects all of the text in the box where your cursor is
located.

Update URL
and Title

Copies the URL and title from the web site currently
displayed in your browser. This button may be useful
if you accidentally change or delete the URL or title
in the MARConnect program.

Check
Spelling

Checks the spelling of your MARConnect data. It will
check the spelling of the title, note, and subject fields.



450 Spectrum CIRC/CAT Reference Manual
SCC5rm1200kn

Record menu commands
The Record menu contains commands to create a new MARC record, save the current
MARC record, and copy the current MARC record to the clipboard.

Command Button Description

New Record Puts a new, blank MARC record on screen. Lets you
edit current information, but does not get the URL
and title from the browser.

This command is different than the New File
command, which creates a new MARC file.

Save Saves your current record. A new, blank record is
displayed and the browser is reactivated after you
click this button.

Copy to
Clipboard

Copies an entire MARC record to the clipboard. From
there, you can paste the MARC record into the
Material Edit part of Spectrum CIRC/CAT.

This command is different than the Copy to
Clipboard command. The Copy command only copies
selected text in one box.
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View menu commands
The View menu contains commands to display the toolbar and status bar and open the
Options window.

Command Button Description

Toolbar n/a Shows and hides the toolbar. If you hide the toolbar,
you can still use the menu commands to use the
program.

Status Bar n/a Shows and hides the status bar at the bottom of the
MARConnect window.

Options Opens the Options window. You should specify your
options before you catalog any web sites.

Help menu commands
The Help menu contains commands to open the Help system and display program
information.

Command Button Description

Help Topic n/a Opens the MARConnect Help system.

About
MARConnect

n/a Provides information about the MARConnect
program, such the product name and version number
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About MARC files

When you catalog web sites using the MARConnect program, your MARC records are
saved to the Marc_001 file. This file is located in c:\Program Files\Winnebago\Spectrum
Client or c:\Program Files\Winnebago\Spectrum Single, depending on which version of
Spectrum you use. The title bar of the MARConnect window displays the file to which all
MARC records are being saved.

MARConnect title bar
The title bar displays the file
to which all MARC records
are being saved.

MARC records are always appended to the Marc_001 file, unless you create a new file.
In most cases, that isn’t necessary.

After you import the MARC file into Spectrum CIRC/CAT, you should move the file to a
different folder in your Spectrum program folder and rename it to the current date. This
will prevent you from re-importing the same MARC records into Spectrum CIRC/CAT.
For more information on moving the MARC file, see "Importing a MARC file into
Spectrum CIRC/CAT" in the Spectrum CIRC/CAT User Manual.

Then the next time you start MARConnect and begin cataloging records, the program
will automatically create a new Marc_001 file.

For more information on the MARC file, see "Saving a MARC record" in the Spectrum
CIRC/CAT User Manual.
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Understanding MARC records

After you have finished cataloging web sites, you can import the file of MARC records
into Spectrum CIRC/CAT. Since the MARC records created by MARConnect adhere to
the MARC standard, they can be imported into all industry-standard library automation
systems.

For more information on using MARConnect, see "Using MARConnect" in the
MARConnect chapter of the Spectrum CIRC/CAT User Manual.

About automatically cataloged fields
Once you’ve accessed the site and clicked the MARConnect button, the program
automatically catalogs the following fields. You can catalog all other fields by entering
information into the spaces provided in the MARConnect window. If you would like to
see where the automatically cataloged information and the catalog information you enter
is mapped in the MARC record, see "Mapping MARConnect fields to a MARC record".

Tag Tag Description

LDR Leader

001 Control Number

003 Control Number Identifier

005 Date and Time of Last Transaction

007 Physical Description Field

008 Fixed-Length Data Elements

040 Cataloging Source

245_a Title Proper
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Tag Tag Description

245_h General Material Designation

256_a File Characteristics

514_a Web site assessment rating

516_a Note: Type

538_a System Detail Note (Mode of Access)

852_p Material number

856_u Uniform Resource Locator (URL)

961_t Material Type

Mapping MARConnect fields to a MARC record
For each site you catalog, MARConnect takes the automatically cataloged fields along
with the catalog information you enter and creates a MARC record. The following
information shows where your entered information and the automatically cataloged
information are mapped in MARC records.

Mapping chart

Source of
data Tag

Indicator
1

Indicator
2 Subfield

Window
the value is

set in

Control number 001 Options

Control number
identifier

003 Options
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Source of
data Tag

Indicator
1

Indicator
2 Subfield

Window
the value is

set in

Language code 008 Options

Cataloging
source

040 b b _a Options

LC call number 050 b 4 _a MARConnect

Dewey call
number

082 0 4 _a MARConnect

Local call
number

090 b b _a MARConnect

(first) Author-
personal

100 1 b _a MARConnect

(subsequent)
Author-personal

700 1 b _a MARConnect

(first) Author-
corporate

110 2 b _a MARConnect

(subsequent)
Author-
corporate

710 2 b _a MARConnect

Title 245 (!) (!) _a MARConnect

Subtitle _b MARConnect

Alternate title 246 2 b _a MARConnect
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Source of
data Tag

Indicator
1

Indicator
2 Subfield

Window
the value is

set in

Place of
publication

260 b b _a MARConnect

Publisher _b MARConnect

Date of
publication

_c MARConnect

General note 500 b b _a MARConnect

Web site
assessment
(rating)

*514 b b (!) Options

Type of
computer file or
data note

516 b b _a Options

Summary 520 b b _a MARConnect

Interest level 521 (!) b _a MARConnect

System details
note

538 b b _a Options

Subject/
subdivision

600 1 4 (!) MARConnect

Subject/
subdivision

610 2 4 (!) MARConnect

Subject/ 650 b 4 (!) MARConnect
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Source of
data Tag

Indicator
1

Indicator
2 Subfield

Window
the value is

set in

subdivision

Subject/
subdivision

651 b 4 (!) MARConnect

Subject/
subdivision

690 b b (!) MARConnect

Local call
number

852 b b _h MARConnect

Material
number

_p Options

URL 856 (!) 0 _u MARConnect

Public note _z MARConnect

Material type 961 w l _t Options

Legend
b = blank value

_ = subfield delimiter

(!) = variable data

* = recommended tag
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About MARC records created by MARConnect
With the data you enter in the MARConnect window along with the automatically
cataloged fields, MARConnect creates a MARC record. The following chart documents
how MARConnect information is used to construct a MARC record.

Source of data Tag
Indicator

1
Indicator

2 Subfield Notes

!!!!!nmmbb22!!!!!b4b4500 LDR See note
1

!!!!!!!!!! *001 See note
2

Control number identifer 003

!!!!!!!!!!!!!!.! 005 See note
3

crbunu 007

!!!!!!nbbbbbbbbxxbbbbb!bbb
zbubbbbbb!!!bd

008 See note
4

Cataloging source 040 b b _a

LC call number 050 b 4 _a

Dewey call number 082 0 4 _a

Local call number 090 b b _a

Author-personal 100 1 b _a
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Source of data Tag
Indicator

1
Indicator

2 Subfield Notes

Author-corporate 110 2 b _a

Title 245 ! ! _a See note
5

Sub-title _b

Alternate title 246 2 b _a

data from computer 256 b b _a

Place of publication 260 b b _a

Publisher _b

Date of publication _c

General note 500 b b _a

web site assessment rating 514 b b _a See note
6

Type of computer file 516 b b _a

Summary 520 b b _a

Interest level 521 ! b _a See note
7

System details note 538 b b _a
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Source of data Tag
Indicator

1
Indicator

2 Subfield Notes

Subjects and subdivisions 6XX ! ! _! See note
8

Added entry (additional personal
authors)

700 1 b _a

Added entry (additional corporate
authors)

710 2 b _a

Local call number 852 b b _h

Material number _p

URL 856 ! 0 _u See note
9

Public note _z

Material type 961 w l (letter) _t

Legend
b = blank value

! = variable data

_ = subfield delimiter

* = numbers are incremented differently

Note 1

The record size and base address (indicated by !!!!!) are calculated based on the size of
the created record.
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Note 2

The !!!!!!!!!! represent an incremented number starting from the Control Number value
that is set from the value you enter in the Control number text box in the Options
window.

Note 3

The tag saved here contains the current date and time in the following format:
CCYYMMDDHHMMSS.S.

Note 4

The current date in the YYMMDD format is represented by the !!!!!! symbols. The
Interest level field supplies the value for the single !. Here, the single ! represents several
different codes:

a = Preschool

b = Primary

c = Elementary and Junior High

d = Secondary

e = Adult

f = Specialized

g = General

j = Juvenile

(if none of the above are given, this code is left blank)

Note 5

Indicator 1 is 0 when there is no tag 1xx, otherwise it’s always 1. The number of non-
filing characters makes up Indicator 2. These numbers are used for the following:

- 2 is used for titles starting with A

- 3 is used for titles starting with An

- 4 is used for titles starting with The
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Note 6

The number here will correlate with the number you enter in the MARConnect window.
It will be any number from 1 to 5 based on the rating you choose. Plus, if you’ve chosen
to include text to precede the assessment, it will show up before the number you specified
as an assessment. Tag 514 is the recommended tag for this information.

Note 7

The first indicator for tag 521 is set as follows:

Category Indicator
value

Audience b

Reading grade level 0

Interest age level 1

Interest grade level 2

Special audience
characteristics

3

Motivation interest level 4

Note 8

Library of Congress has specified the subject tags, subfields, and indicators.

Source of data Tag Indicator 1 Indicator 2

Personal name 600 1 4

Corporate name 610 2 4
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Source of data Tag Indicator 1 Indicator 2

Topical 650 b 4

Geographical
name

651 b 4

Local 690 b b

Note 9
If the URL starts with "http:’, the first indicator is 4.

If the URL starts with "ftp:", the first indicator is 1.

If the URL starts with "telnet", the first indicator is 2.

If an @ is found in the URL, the indicator is set to 0 (zero) for e-mail,
otherwise the indicator is 4.
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Example of a cataloged site
Here’s one way you can enter your site data. Some fields in the MARConnect window
don’t apply for all sites. In these cases, you can leave those fields blank. The site data
below comes from the web site titled Abraham Lincoln. The site’s URL is
http://www.geocities.com/SunsetStrip/venue/5217/lincoln.html.

Field name Site data

URL http://www.geocities.com/SunsetStrip/venue/52
17/lincoln.html

Author – personal Donovan, Michael

Title Abraham Lincoln

Publisher Geocities

Date of Publication 1997

The quality of this page or site 4

General note The site is hosted by Geocities

Summary General research information about Abraham
Lincoln, such as his childhood, his family
members, his life as president, his famous
speeches

Public note For more information on Abraham Lincoln or
related topics, see the library’s Reference staff

Dewey call number 921
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Field name Site data

First subject (topical) Presidents

 Subdivision (general)  Biography

 Subdivision (geographical)  United States

Elements of a MARC tag
A MARC tag identifies a field of a material record in MARC format. For example, tag
number 100 identifies the author of a material. The following is an example of a Pre-1987
MicroLIF tag. It’s shown in this format for easy readability.
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